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1 INTERFACE

1.1 MAIN PAGE
The Main Page is divided into the main graphics area, the pages area on
the right and the toolbar along the top.

P (urted projec - 85ea 2062 it

Del ecu==D00ryx2EamE » &

Pages Area

Orotx 20 rot y -0 z00m 0 130MB

1.1.1 Graphics area

The main graphics area shows the current project environment, either in
3D view or cross-section. Noise sources, probe locations and calculated
sound levels are displayed over the project bathymetry. For information
on controlling the graphics display, see Controlling view and display 2.1 p.
33

OpenGL is used to display the graphics. The OpenGL version provided by
Windows 7, 8 & 10 (glu32.dll) is typically sufficient, however users who
experience problems with the graphics display may benefit from
obtaining updated OpenGL drivers from their graphics card vendor.

1.1.2 Pages area

Scenarios, sources, seabed, and other input properties of the current
project are edited and controlled by the individual pages that show in the
pages area. The relevant pages are accessed via the buttons in

the toolbar.

1.1.3 Toolbar
The buttons in the toolbar control creating new projects, opening, saving,
changing the view, accessing specific pages and solving the current
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project. Hovering over each button shows the function of that button as
tooltip text.

1.1.4 View Menu

The visibility of individual components (source, probes, bathymetry,
sound levels) is controlled by checking or unchecking the items in this
menu.

Cross sections can be saved, recalled and named from this menu.

The ability to grab probes and sources can be toggled on or off in thim
menu as well (“Can select sources/probes”).

1.1.5 Tools Menu
Load bathymetry CSV - see Reading CSV files 2.4 p. 41.

Swap heights and depths - dBSea accepts input bathymetry with depths
as positive numbers and land heights as negative numbers. Many GIS
tools use the reverse definition, and if this is the case with imported
bathymetry, this option will reverse the imported heights and depths.

Source/Probe array tool - A useful tool for creating large arrays. It allows
you to copy a source or probe to create an array easily.

Latitude/Longitude to Easting/Northing Calculator - Can help you
convert decimal degrees or DMS notation to UTM coordinates. The tool
will use the UTM zone of the first coordinate set as the reference for the
remaining coordinates.

Remove calculated levels from .UWA file - In case you wish to strip the
calculated levels from a saved file. This will greatly reduce the size of the
saved file (but levels must be recalculated).

New project with specified bathymetry depth - Generates a new, flat
bathymetry of the given depth, with length and width of 10,000 m.

Launch CSV Editor - This option will start the bundled CSV editor 2.8 p. 48,
which is used to import and edit bathymetry files from different formats.

View dBSea Log - Lets you view the list of actions performed by dBSea,
and export this. Useful for support queries.

Generate C2V file - This will generate a unique file that we use to upgrade
product keys.

Preferences - Opens the Preferences (p 45) window.
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1.1.6 Export Menu

Export current scene as... - An image file containing the current scene
may be exported by choosing the 'Export the current scene as...' button
from the Tools menu. BMP, JPG, PNG and PDF file types may be exported.
If the current scene includes calculated sound levels, then the exported
image will include a scale bar showing the colour scale for levels.

Export all levels/cross-section levels - Calculated sound level data may be
exported in text format, with tab separated fields. The data can therefore
be opened or copied directly into a spreadsheet. Data may be exported
as the overall levels at each point, or the overall levels plus full spectra for
each point may be written.

Export currently visible levels/bathymetry in ESRI Ascii grid format - This
option will write an output file containing the currently visible sound
levels or project bathymetry, in the widely supported ESRI Ascii grid
format, for import into GIS packages. When exporting levels, if

the solution grid dx/dy aspect ratio is close to 1, dBSea will use the
standard CELLSIZE parameter. If the aspect ratio is too high, then the
non-standard DX and DY parameters will be used, which may not be fully
supported by all GIS software. To use a square or close to square grid
aspect ratio, click on the 'Square aspect ratio' button on the Project setup
1.3p. 8

Export exclusion zone - This can either be as an ESRI Ascii grid or as an
ESRI shapefile (.shp, .shx, .dbf).

1.2 SCENARIOS N
Manage scenarios ’i
A problem may contain any number of scenarios. Scenarios

allow comparison between different environmental situations, sources,
mitigation, grids and solvers. Each scenario contains:

e Sources

o GCrid

e Probes

o Water sound speed profile
e« Seabed

o Weightings

« Solver and frequency selection

Bathymetry and the overall world dimensions are shared by all scenarios.
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Use this page to manage scenarios: add, delete or duplicate scenarios
with the given buttons. To make a scenario active, click in its 'Activate’
column. Click in the 'Solve' column to enable and disable solving for each
scenario (disabling a scenario from solving will keep any calculated results
that exist for that scenario). If a scenario currently has calculated results,
this is shown in the 'Levels' column.

1.3 PROJECT SETUP
Set up the overall project world 4

A problem consists of the following elements:

« Bathymetry
e Scenarios, containing:
o Sources
Crid
Probes
Water sound speed profile
Sediment
Weighting

O O O O O

Bathymetry is the gridded data representing the seafloor. At each point in
the grid, a depth (or if negative, a land height) is given.

Sources represent the sound sources within the problem. A problem can
have any number of sources, each producing a given sound spectrum or
time series.

The grid represents the entire problem area, in which sound levels are to
be calculated. Points are evenly distributed in the x and y directions and
sound levels are assessed at those points, by summing the contribution

from each source.

Probes are used to show the sound level and spectrum at particular
points in the grid, and may be thought of as hydrophones. The grid may
contain one or more probes.

The water sound speed profile represents the speed of sound in the water
column.

Sediment gives the fluid properties of each of the layers in the seabed:
density, speed of sound and attenuation. The seabed can have any
number of layers.

Weightings represent the hearing of different marine species, against
which the calculated sound levels are compared, giving a weighted sound
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level. The database contains both M weightings and species specific
hearing thresholds. More weightings may be added to the database if
desired.

1.3.1 Problem creation

dBSea initially loads with some sample bathymetry data, showing an area
of the Irish sea and surrounding land. When creating a new problem, the
bathymetry data is set to be all flat, at a depth of 100m. New bathymetry
data may be imported from a CSV file (Project setup-> Load bathymetry).
CSV files can be created in most spreadsheet programs, or may be
created and edited using the included CSV editor (p. 48) program. Each
'‘pixel' is a depth in metres, separated by a semicolon. Example files may
be found in the program directory. For more information on reading CSV
data see Reading CSV files p. 41.

A very large amount of bathymetry data can slow down the program
graphics, if this is the case then the graphical bathymetry data may be
reduced (Preferences -> Graphics - > Max bathymetry graphics data). This
reduces the amount of graphics processing required, while the underlying
calculation retains the bathymetry data at full accuracy. The bathymetry
layer is cached by the graphics layer, so while the first draw of new
bathymetry may be slow, subsequent draws are much faster and
therefore the size of imported bathymetry is seldom a problem in
practice.

1.3.2 Properties map

Starting at version 2.0, dBSea allows definition of water and sediment
properties at any location. Each set of properties is defined at a given
location based on easting and northing.

The solvers interpolate these properties at any given point via an inverse
distance weighting.

The properties map locations and names can be edited in the Properties
map form in the Setup project page. Properties locations can be added,
duplicated and removes. Locations are shown as coloured circles, with the
current point indicated by a pulsating ring. Colours of points can be
changed using the “Colour” button.

To set the properties of the points, use the relevant form i.e. “Water
properties page” and “Seafloor properties page”.

Alternatively, use a JSON file to import many points in and automated
fashion. Below is an example of an import:
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"easting": 1234,
"northing": 5.678e3,
"name": "A name",
"comments": "Some comments",
"colour": "#££0000",
"water": {
"temperature": 20,
"salinity": 35,
"velocity": 10,

"direction": 1.2e-01,
"name": "A name",
"comments": "Some comments"
b
"ssp": |
"cProfile": {

"depth": [0, 10, 15, 20, 557,
"c": [1500, 1510, 1520, 1510, 1500]
by

"name": "A name",
"comments": "Some comments"
b
"seabed": {
"name": "Seabed name",
"comments": "Seabed comments",
"isReferencedFromSeafloor": true,
"layers": [
{
"depth": O,
"name": "A name",
"comments": "Some comments",
"material": {
"c": 1700,
"density": 1500,
"attenuation": 0.1,
"name": "A name",
"comments": "Some comments"

}
brd
"depth": 10,

"name": "A name",
"comments": "Some comments",
"material": {
"c": 1820,
"density": 1810,
"attenuation": 0.05,
"name": "A name",
"comments": "Some comments"
}
}
]
}
"easting": 12342,
"northing": 56782,
"name": "A name2",
"comments": "Some comments2",

"colour": "#00ffo00",
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"water": {
"temperature": 5,
"salinity": 3,
"velocity": 2.7,
"direction": 0.2,
"name": "A name",
"comments": "Some comments"
b
"ssp": |
"cProfile": {
"depth": [0, 10],
"c": [1500, 1530]
b
"name": "A name",
"comments": "Some comments"
bo
"seabed": {
"name": "Seabed name 2",
"comments": "Seabed comments 2",
"isReferencedFromSeafloor": true,
"layers": [
{
"depth": O,
"name": "A name",
"comments": "Some comments",
"material": {
"c": 2510,
"density": 2000,
"attenuation": 0.1,
"name": "A name",
"comments": "Some comments"

br o

}

"depth": 20,

"name": "A name",
"comments": "Some comments",
"material": {
"c": 2400,
"density": 2500,
"attenuation": 0.05,
"name": "A name",
"comments": "Some comments"

Notes on JSON files:

- Name, comments and colour fields are optional, other fields are not.

- Colour fields accept html-style colour codes.

- Numerical fields may be entered as 1234.567, 1.234e3, 987.6e-05 and

other variations on scientific notation.
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The outermost list, between “[* and “]”, may be extended to include
any number of entries.
Sound speed profiles (SSPs):

o The number of entries in “depth” and “c” must match, however
different locations can have different lengths.

o When interpolating SSPs, shorter lists have entries added as
needed, via linear interpolation or nearest neighbour (when
extrapolating). The scenario-wide depth list is the union of all
depths entered.

o Interpolation of sound speed within SSPs is inverse distance

weighting.
o Example:
"Ssp": {
"cProfile": {
"depth": [ 0, 10, 207,
"o [1500, 1510, 1520]
b
"name": "SPP one",
"comments": "one SSP"
b
"ssp": {
"cProfile": {
"depth": [ 5, 15, 257,
"c": [1505, 1510, 1520]
b
"name": "SSP two",
"comments": "another SSP"

I
SSP at midpoint between SSP_one and SSP_two is:

“depth” : [ 0, 5, 10, 15, 20, 2571,
we s [1502.5, 1505, 1508.75, 1512.5, 1517.5, 15201,
Sea bead

o Density is in kg/m?.
o Each entry musthave the same number of seabed layers, and
the layers must appear in order of increasing depth.
o Layers of thickness ‘O’ are allowed and are achieved by setting
the layer depth the same depth as the preceding layer.
o Seabed properties, including depth of layer, are interpolated
via inverse distance weighting.
Please feel free to use the above example as a template to ensure
correct syntax and field inclusion.

Shape overlays

From dBSea 2.0 you can import shapefiles (.shp & .shx) into dBSea. As
dBSea work from northing and easting, the location of your shapefiles will
be most accurate if they are using this system too. If your shapefiles are in
lat/lon format, dBSea will use the UTM-zone of the centre of the
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bathymetry to convert the lat/lon coordinates into northing and easting.
This process may skew your shapefiles if the UTM zone does not match, or
the bathymetry area is very large.

1.3.4 Image Overlay

Starting in version 2.1, dBsea can import pictures as image overlays to
change the appearance of the landmass included in a scenario.

dBSea accepts .jpg & .jpeg, and you have the option of adding information
on the image projection by adding an ESRI World File with the same
name, but or “.jpw” as file extension, in the directory where the image is
loaded from.

E.g. | have the following two files in my folder:

- Gibraltar.jpg (Image)
- Gibraltar.jpw (Projection information)

dBSea will look for these files and include the information when
importing. If no file is found, the image is simply loaded "as is".

On the "Setup project” page find "Image overlay" to open the import form.

P image overlay - a X

E] Lock aspect rato on map drag

West x (m) | Neorthy (m) | Cear mage [ Load image l

Eastx(m) | | Southy (m) Reset scale o Cancel
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In this example a .jpg image of a satellite view of the Gibraltar Strait.

The "Lock aspect ratio on map drag" mean that dBSea will preserve the
proportions of the image as you place it on the map, disable this if your
bathymetry and your image are not in the same projection.

The fields "West x (m), East x (m), North x (m) & South x (m), can be used
to give the extend that the image covers.

All these values are relative to the south-west corner of the relevant UTM
zone. in the above example that means:

- West x (m) is the Easting (UTM zone 30) of the most western part of
the image.

- East x (m) is the Easting (UTM zone 30) of the most eastern part of
the image.

- North x (m) is the Northing (UTM zone 30) of the most northern part
of the image.

- South x (m) is the Northing (UTM zone 30) of the most southern part
of the image.

After pressing "OK" you return to the main window in dBSea, with the
image overlay.

If the image has not been cropped carefully, or no .jpw file was found, you
need to fit the image by re-sizing and moving it using the five nodes. (If
"Lock aspect ratio on map drag" was checked, you can't change the image
proportions).
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1.3.5 Setup cross section

Clicking the Setup cross-sectionbutton shows the current cross a
section location in the 3D view. The endpoints of the cross

section may be dragged to the desired location. Once the

location is selected, clicking the Show cross-section button in the main
toolbar changes to cross-section view.

If you have multiple sources in your scenario, the endpoint of the cross-
section can be made to jump to any source using the number 1-9 as index
for the first 9 sources in your scenario.

The cross-section can also be specified by entering two points in the "Set
up cross section -> Coordinates" menu.

1.3.6 Set world scale

Setting the world scale tells the program the overall size of the problem
area. Clicking the Set world scale button resets the 3D view. The user then
clicks on two known points in the project area, and enters the distance
between them, or the absolute locations of the two given points. This
scales the overall size of the project area, and if absolute positions are
given, also sets the project Northing and Easting. Instead of clicking on
the first point, pressing the number keys (1, 2, 3...) will set the first point to
the location of the corresponding source, if one exists.

1.3.7 Northing, Easting & UTM zone

The lower left corner of the project area is initially situated at 0,0.

Adding Northing and Easting changes the location of the project area. This
function may be useful when matching locations given in different
coordinate systems.

If the imported bathymetry was geotagged, dBSea will choose a suitable
projection for the data, based on the UTM zone of the centre of the map.
dBSea uses the expanded notation for UTM zones, meaning that all places
have a numerical code (01-60) counting from the meridian at 180 degrees
west to the meridian at 180 degrees east in 6 degree increments, and an
alphabetical code based on latitude (C-X, omitting “I” and “O”).

Note that some official UTM zones don't follow this grid, around Norway
and Svalbard. dBSea ignores this and calculates zones as if the grid was
not distorted in those areas. In addition zones A, B, Y and Z are not
covered.

See this map (interactive) for UTM grid with coordinates (uses google
maps/earth). Alternatively download the ESRI shapefile.
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1.3.8 Grid setup

On the problem setup page, the number of grid points may be altered.
The grid is rectilinear (Figure 1), and the number of points may be altered in
the x, y and z (depth) directions. The same z spacing is used for source
solutions as for the grid.
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Figure 1. Example problem grid in plane view.

dBSea doesn't require that the x and y grid spacing match, however this
can be an issue when exporting levels. If the x and y spacing are
sufficiently close, ESRI Ascii grid exported levels will use the standard
CELLSIZE parameter and effectively give square cells. If the x and y
spacing differ by too large a factor, the non-standard DX and DY
parameters are used for the output file. These parameters are not
supported by all GIS software, so check with your GIS package as to
whether this data will work. A square aspect ratio can be ensured by
clicking on 'Square aspect ratio'.
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Alternatively, use the button "Set to map resolution”, dBSea will match the
calculation grid to the resolution of the bathymetry. Remember to check
that you are happy with the resolution by inspecting "Step sizes".

1.3.9 Source setup

The number of radial solution slices about each source and the evaluation
range points along those slices (Figure 2) may be altered on the problem
setup page.

Figure 2. Example source with solution points.
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If a solution only along a single direction is required, set the number of
slices to 1(in which case the solution is valid only in the positive x
direction from the source, i.e. heading to the right).

1.3.10 Memory requirements

A large number of grid or source solution points can greatly increase the
amount of memory required. The approximate amount of free memory
needed is

bytes =

4- ((xgrid size " Ygrid size) + (nsources *Nyange points * Msource position)) " Zgepth points * Nfrequency bands

Attempting to increase the number of points beyond available memory
will be blocked by the program.

1.4 FREQUENCIES AND SOLVERS PAGE ~,
Calculation may be at octave or third octave centre frequencies. —
Source equipment spectra is stored in either octave or third

octave bands, depending on the original source. If calculation is in octaves
and the original spectrum is in third octaves, then the 3 1/3 octave band
levels are summed together to give the octave band level, e.g. the 200,
250 and 315 Hz 1/3 octave bands are summed to give the 250 Hz octave
band level. If the calculation is in third octaves and the original spectrum
is in octaves, the energy from the octave band is split evenly between the
31/3 octave bands (so each band receives the octave band level minus
10+logi0(3), or approximately 4.77 dB).

The highest and lowest assessment- and solver split frequencies may be
changed with the up and down buttons. For octave band calculations, the
lowest and highest possible bands are 16 Hz and 128 kHz, for 1/3 octave
band calculations the limits are 12.5 Hz to 160 kHz.

When 'Use separate solvers for low and high frequencies' is checked, the
low and high frequency solvers may be individually chosen and the solver
split frequency changed.

The solver can be changed between those available. For more on the
available solvers, see Solvers p. 36

1.5 SOURCES PAGE D
Add, remove, edit noise sources o
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Multiple sound sources may be placed in the environment. A scenario
may be solved in the frequency domain or the time domain, and all
sources in the scenario must be solved in the same domain. A problem
can contain scenarios with a combination of frequency and time domain
solves.

Sources may be moved by entering coordinates in the Source page fields,
or by clicking and dragging the source in the x and y directions with the
mouse when in bird's eye view mode (press Reset View button).

If you wish to disable clicking and dragging go to View=>Can @
select probes/sources.

The current source is selected from the dropdown menu. Sources may be
added and removed with the Add, Remove and Make copy buttons.

The source sound level or time series are not set directly on this page. To
edit the spectrum for a source, click on the 'Spectrum' button. This shows
the Spectrum page form (p. 22). To edit the time series for a source, click
the 'Set time series' button, which shows the
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Source time series page form (p 27).

As a scenario can only contain either frequency-based or time series-
based sources, changing between these types will change all sources in
the current scenario.

Directivity data for the source is entered on the Directivity Page, p. 28,
accessed by clicking the Directivity button.

Position data is stored with a precision of 0.1 m. This is true for all
positional info, i.e. sources and probes.

The solvers will ignore sources placed on land.

To temporarily disable a source without removing it, uncheck the Source
enabled box.

1.5.1 Importing multiple sources
The Import CSVbutton will import a list of sources from a CSV file. There
are several important restrictions on the format of the input CSV file:

The data (and every row of the data) must have 4 columns. The columns
are Name, X, y, z. A header row (i.e. "Name,x,y,z") is optional. Each
subsequent row represents a single source. The Name field is a free text
field, and the x, y and z fields must contain numbers, and will be
interpreted as feet or meters, depending on the current imperial/metric
units setting. It is not necessary to enclose the name field in quotation
marks.

The following image shows an example that will import 3 sources, as
shown in a spreadsheet.

_ A _ B ] C _ D | :
1 |Name X y z
2 |Source 1 name 1500 1200 10
3 |Source 2 name 6400 1900 20
4 |Source 3 name 5000 3500 30
5

Saving as a CSV file produces the following as a text file.
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MName,X,V, 2

Source 1 name,1500,1200,10
Source 2 name, 6400,1900,20
Source 3 name, 5000,3500, 30

1.5.2 Moving/line sources

A source may be stationary or moving/line. The available solvers do not
calculate true line sources, instead a moving or line source is
approximated by calculating the levels for a series of point sources along
the desired source route. Increasing the number of intermediate points
along the route increases the accuracy of the approximation, at the
expense of calculation time and memory requirements.

Clicking the Moving source checkbox enables the Motion button, which
shows the Set source motion form. On this form, add and remove
waypoints by clicking in the Add or Remove column. Add as many
waypoints as needed to define the source path.

The x, y and z columns give the location of each waypoint. The
Time/Speed column contains the time taken/speed for the source as its
travelling from the preceding waypoint (on the row above) to the current
waypoint, and the Points column contains the number of points between
the waypoints where sound levels should be calculated. The position of
the point at positionindex (starting from 1) between the waypoints is given

by:

, , pointingex , ,
POiNntyosition = Waypoint, + - (waypoint,,; — waypoint,)
npoints between waypoints

The values in the Time column are in seconds. The total scenario period is
taken as the greatest total time for any of the moving sources in the
current scenario. Other moving sources in the scenario are inactive after
their motion is finished. All stationary sources are taken to be active for
the entire period (and then modified by the Duty % parameter in Sound
sources=>Spectrum).

For time domain solves, it is assumed that a single instance of the time
series is short in comparison to the overall source motion, so that the
source does not move while the time series is emitted.
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1.5.3 Cross section

A simplified cross section for the current source can be viewed by clicking
Cross section. If there are calculated sound levels, the levels along the
current slice are shown. The current slice may be changed with the
up/down buttons or by clicking on a direction in the compass rose.
Clicking the To cross section in main window button shows the chosen
cross section in the main graphics area. There are additional options to
export cross sections and to alter the view of these.

1.5.4 Display thresholds

In the Display of optional thresholds for this source area, it is possible to
show a given threshold around the current source. Entering a threshold
level in the text box or choosing one of the available thresholds from the
dropdown list, and pressing the Show threshold button, enables display of
the threshold. In the main graphics area, a circle around the source shows
the average distance to the threshold, and a line emanating from the
source shows the maximum distance and angle to the threshold.

1.6 SPECTRUM PAGE

The spectrum and overall level of a sound source are edited on this page.
A source is composed of 1 or more pieces of equipment. A maximum of 4
different types of equipment may be combined, and there may be any
number of each type of equipment. To select equipment, press the 'Add
Equipment buttons. This will bring up the
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Levels may be directly edited if desired. Click on the appropriate cells and
enter the levels. Note that it is not possible to directly enter an overall
level, only levels of individual frequency components can be entered, and
the overall level is summed from these contributions.

Equipment page (p 26).

Increasing the entry in the Count column multiplies the given row by that
factor, this is used for multiple collocated sound sources of the same type.

The Duty % column specifies the percentage of time that the given
equipment is active during the assessment time period.

The Level type box allows different level types to be selected:

/ Zg=1 P(n)z\
N

dBSL @ Im: dBg, = 20-logy, | I

\ 1-10-6 Pa /

With “p,,” being the pressure in pascals a at sample number “n” and
“N” the total number of samples.

SWL (Lw): dBy, =10 - l0g1o (o)

Sound power level, source power in watts relative 1 picowatt.

SEL: SEL = dBSL +10- loglo(S)

or

ftt) P(t)%dt
(1-1075)2 Pa

SEL = 10Log+,

With “s” being the duration (in seconds) of the SPL used to calculate the
SEL.

Note that changing the level type will also scale the currently entered
level values, so it is recommended to choose the level type before
entering source level data.

Be very careful to ensure that you enter your values under the correct
unit.

The Crest factor (dB)is a way to incorporate impulsiveness information
into the source. The Crest factor indicates the dB-level above the RMS-
level of the highest peak in the signal. It is applied when assessing peak
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levels (Preferences>Sound level display>Peak sound pressure level), and
is applied to all frequency bands. If you are interested in finding peak
values please consider doing a time series solve instead, as it uses the
actual signal and not derived information.

1.6.1 Mitigation

It is possible to add mitigation (attenuation, such as bubble curtains) to
this source, by clicking on 'Add mitigation'. Mitigation may be entered as a
constant value across all frequencies, or by choosing mitigation spectra
from the library. Positive mitigation values indicate reductions in emitted
sound level.

1.6.2 Copy to clipboard
The contents of the table may be copied to the clipboard with the 'Copy
to clipboard button.
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Name

Total :

Level (dB)

Vibration pilig

Count

1

215.5d8

s

Duty % Level
100.0 220.4
215.5

3.5
215

210

40
212

207

50 63 80
210 213 212
205 208 207

100 125 160 200 250 315 40C
205 206 205 202 203 200 195
200 201 200 197 198 195 19

Copy to dlipboard

40

100

125

160 200 250 315

(Hz)

400 S00 630 800 1k 12k 16k 2k

Addequp | [ Removeequp |
Add equip | Remave equip l
Add equip | Remove equip |
Addequp | [ Removeequp |
Add mitigation | | Remove mitigation l

Level type (dB levels re 1uPa)

@ Sourcelevel dBSL@ Im

*) Source power level  dB SWL Lw (re 1pW)

Sound exposure level dB SELcum @ TO = 1s

Assessment period (s) 3600
‘ 1hour 24 hours
Crest factor (d8) 12
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1.6.3 Equipment page

The equipment page allows selection of items of equipment from the
database. The database is divided into categories such as piling, drilling
etc. The list of items may be searched by typing in the search box.

The spectrum of the currently selected equipment is shown in the chart
and table, along with any associated comments.

Note that data for each item may be stored in either 1/3 octave or 1 octave
bandwidth, and it will be interpreted according to the current calculation
bandwidth, i.e. the energy summed into 1 band, or spread out over 3
adjacent bands as appropriate.

Piing
Dredging
Vessels
Turbines
Other

/| Default library [¥] User added equipment

Name Category  Level 250Hz 500Hz

Piling 1.5m diameter Piling 226.8 - 222 217

Comments

Jacket pile construction, diameter 1.5 m per pile, water depth ~30 m. (ITAP 2005). Measured at 400 m from the source. The
original measurements were back-calculated to 1 m after Thiele 2002

Data source: default library

Database

New database equipment
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1.7 SOURCE TIME SERIES PAGE

The time series for a source are edited on this form. A source can have an
overall time series representing a single event, such as the firing of an
airgun. Data is imported either from a text file containing the individual
samples on separate lines or a wav file.

For the text file import values should be given in Pascals, as in the
example below:

-16219.25685
=53345.41704
-87190.2246%9
=113253.53817
-128347.76087
=130504.07825
-120285.00881

-6843.96387
17906.80959
33001.03128
355807.37211
25875.80862
4218.88184
-26157.06741

If you import a wav file, scale the pressure to reflect the real values (.wav
files are usually scaled from -1to 1 and thus do not contain information on
the actual sound pressure).

The sample rate value is used to filter the signal into frequency bands. The
count value is used with moving sources, where it is desired to have
multiple events at each calculated source position.
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1.7.1 Mitigation

Mitigation is entered for each frequency band, and dBSea recalculates the
band filtered time series data with these mitigation values during the
solve phase. As with the source spectrum page, positive values of
mitigation effect a reduction of sound level in that frequency band.

Open text file Open WAV file Sample rate (Hz) (192000 Count (per assessment period for static source or per position for moving source)
Scale pressure by Scale

1
09

0.8
07
06
05
04
03
02
0.1
o
-01

Prassure (Pa)

-02
03
-0.4
-05
-06
-07
-0.8
-09

-1

t(s)

f(Hz) 12.5 16 0 25 315 40 50 63 30 100 125 160 2
Level 58.2 60.1 62.2 64.4 64.6 627 64.5 67.8 67.6 65.2 68.7 75.4

Mitiaation
< > OK Cancel

1.8 DIRECTIVITY

The source directivity is set per frequency on this form. Data may be
entered directly, or imported from a text file containing each entry on a
separate line. To import a text file covering a given frequency, click on the
'File' cell at the top of the column for that frequency.

-90 degrees is vertically up, O degrees is horizontal to the source, and +90
is vertically down. Directivity values are linearly interpolated between the
given values where needed. Greyed-out rows indicate that the angle is
outside the current range of starting angles set for dBSeaRay.

The directivity data is used by the dBSeaRay solver.
dBSeaPE and dBSeaModes do not support source directivity.
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1.9 WATER PAGE
Water properties, current and sound speed profile -""

1.9.1 Speed of sound profile

The vertical sound speed profile is set on this page. Some default profiles
may be selected from the dropdown menu. Note that if a profile is listed
as 'normalised' then the given profile will be scaled so as to extend from
the water surface to the greatest depth in the current model. Profiles that
are not normalised will use the depths stored with the profile.

The current profile may be modified:

o Double click on the graph to add a new control point
o Double click on an existing control point to remove it
o Click and drag to move existing control points

The profile is linearly interpolated between control points.

If you create a new point at a higher or lower speed than any existing
points, it may seem like the point is created at the wrong position - this is
because the graph x axis rescales if necessary when new points are
added.

If multiple positions have been entered in Setup project>Properties map
there will be a dropdown menu at the top right, for selecting the relevant
location.

1.9.2 Ocean current
A constant ocean current may be entered in the field. The direction may
be entered by clicking directly on the compass rose.

1.9.3 Water properties

The water temperature and salinity may be entered in the appropriate
fields. Pre-set properties may be selected from the dropdown box. The
graph shows the water absorption with frequency, in units of dB/km.

1.10 SEABED PROPERTIES PAGE

Seabed properties .

The Seabed Page allows the properties of the seabed layers to
be changed. The seabed may consist of any number of layers.

The currently active layer is selected in the top dropdown menu. Layers
may be added with the add and remove buttons.
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If multiple positions have been entered in Setup project>Properties map
there will be a dropdown menu at the top right, for selecting the relevant
location.

Every location must have the same number of layers!

Everything below the Layer depths referenced from local seafloor
checkbox refers to the currently selected seabed layer. The layer may be
named, and the depth where the layer starts is entered in the Depth text
box.

A sediment type from the database may be selected via the dropdown
menu. The selected properties can be modified by entering values in the
text boxes.

Attenuation is given in units of dB/wavelength. The 20 log and 10 log
solvers ignore the seafloor altogether.

If the Layer depths referenced from local seafloor checkbox is checked,
then the solvers will take the layer depths as being referenced from the
local seafloor at each point in the solution. If it is not checked, the layers
are taken as referenced from the sea surface. So with this option it is
possible to choose between seafloor layers that are horizontal throughout
the entire project area, or that follow the local variations in bathymetry.

The calculation area for the dBSeaModes and dBSeaPE solvers extends
lower than the water column, to a total depth of three times the depth of
the water column. Any layers that fall within this are will be included in
the calculation. The dBSeaRay solver does not allow rays to enter the
seabed, however an effective complex reflection coefficient is calculated
based on frequency, incidence angle and sediment layers. This coefficient
is applied to the ray upon reflection at the seafloor.

It should be noted that the speed of sound and density of typical soft
sediment layers are generally similar to those of the overlying water.
Therefore the seafloor allows a large portion of incident energy to enter,
in contrast to the air-water interface.

1.11 MARINE SPECIES WEIGHTINGS PAGE
Marine species weightings -

This page shows the weighting curves for various species of

fish and marine mammal, which may be selected from the database using
the dropdown box. The 'None' entry may also be selected, where no
weighting is desired.
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The currently selected weighting curve is used throughout the program to
calculate weighted levels. The levels displayed in the main graphic
window are weighted levels.

When exporting levels, overall weighted levels are exported, however if
spectra are included, the individual frequency components within each
spectrum are exported as raw unweighted levels.

1.12 PROBES PAGE

Noise level probes }
Probes are used to get more control over display of predicted

sounds levels, and may be thought of as hydrophones. Sound levels are
calculated throughout the project area, but to see the spectrum and level

at a specific point, place a probe there. A scenario can contain multiple
probes.

Probes are moved by entering x and y values in the fields, or by clicking
and dragging in the main graphic window. The z coordinate is connected
to the current vertical levels display method Preferences -> Graphics ->
Sound levels display. When this is set to 'Max from all layers projected to
surfacé', the level shown is the maximum from all vertical layers at that x
and y location. When this is 'Single layer, the level shown is from the
given z coordinate. These controls can also be accessed directly from the
Probes page by clicking the 'Show depth controls' button.

Probes may be added and removed with the 'Add probe' and 'Remove
probe' buttons. The current probe is selected with the dropdown box. The
chart shows the spectrum at the current probe location (blue bars), with
the current criteria overlaid (blue line). To show the variation in level with
depth at the probe location, click the 'Levels vs depth' tab.

The 'Table to clipboard button copies the current results showing in the
results table to the clipboard, with the fields separated by tab characters.
This data can be directly pasted into a spreadsheet, if the spreadsheet
field delimiter is set to the tab character.

1.13 RESULTS PAGE
Overall levels and colour scale IIII

The Results Page gives control over the display of sound levels.

The current mapping of sound levels to colours is shown. Depending on
whether 'Smooth result colours' is selected under Preferences-> Graphics,
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the results colours will either be displayed as solid colour bands, or will
blend smoothly into one another.

To alter the limits or the spacing between colour bands, click the 'Change
limits' button. This shows the level limits dialogue.

4 Set level limits

Max level (dB) 150

Global levels histogram

| Show exdlusion zone

Min level (dB) 130
Level (dB)

Spacing between bands
1d8 Choose threshold v
3dB

®)5d8

10d8 Set exdusion zone colour

20dB

Reset oK Cancel

The maximum and minimum level to show may be changed, and the
spacing between adjacent bands may be setto 1, 3, 5, 10 or 20 dB.

1.13.1 Exclusion zones

To show exclusion zones around sources, check the Show exclusion zone
box. The exclusion level is entered in the Leve/text box, or may be chosen
from the dropdown box which contains thresholds from the database.

If using predefined levels from the dropdown menu, please make sure
that the variables in “Preferences” - “Sound levels display” are set to
“Sound exposure level dB SELcum” and “Assessment period is set to
86400 seconds (24 hours) to comply with the assessment standards (and
that your source is suitable for this). Please also make sure that you
understand the background of the weightings (NOAA, 2016). Also,
predefined impulsive thresholds are only available for time series sources,
as they are not clearly defined in the above document. If you wish to
assess a continuous sound source as impulsive set the exclusion zone
manually to the desired level as per (NOAA, 2016).
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The main graphics area will show all areas where the currently selected
minimum level is exceeded, coloured with the chosen colour. The colour
may be changed with the Set exclusion zone colour button. If the Levels
must decrease with distance from source option is not selected, this may
cause problems for the exclusion zone
drawing algorithm, therefore it is
recommended that this option is Colowr

selected when exclusion zones are 7
[
=
——

v

desired.

To change the colours for the displayed
results, click the 'Change colours' :
button. This shows the colour edit | |
dialogue.

To change the colour for a particular
band, click on that colour. To set a band
to be not visible, uncheck the 'Visib/e'
box for that band.

2 SETTINGS AND BACKGROUND

2.1 CONTROLLING VIEW AND DISPLAY

2.1.1 Changing between 3D and cross section view

To change to 3D view, press the 3D toolbar button. '@
To change to cross section view, press the cross-section
toolbar button.

_--"__’L
To measure distances in the 3D environment, press the ruler "Er:f:ﬁ

button.
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2.1.2 Controlling the 3D environment view

With the mouse in the display area, the view may be rotated, panned and
zoomed with the mouse:

e« Topan: Right Click, Ctrl + Right Click, Alt + Left Click
o To Rotate: Ctrl+ Left Click
e ToZoom: Mouse Wheel, Ctrl + Middle Click, Shift + Left Click.

To reset to a bird's eye view, click the Reset View button. When

in this bird's eye view, objects (sources and probes) may be left <@?
clicked and dragged within the environment, and scale markers

are shown along the x and y axes. Once the view is rotated,

objects may no longer be dragged.

When the mouse cursor is over the display area, the info bar at the
bottom of the main window gives information on the current mouse
location and view state (pan, rotation and zoom). In addition, when
dragging objects in the view window, the current x and y location will be
shown.

2.1.3 Display of components
The visual depth scaling can be changed on the options page with the Z
scale slider. Land and water colours can be altered on the preferences

page.

Visibility of individual components can be turned on and off via the View
Menu 1.1.4 p. 6.

2.1.4 Setting the cross-section

Before the cross-section view can be shown, the cross-section position
must be set. Clicking the cross-section view toolbar button or choosing
Setup cross-section from the project setup page shows the location of
the cross section, in bird's eye view. Click and drag the endpoints to move
the cross-section. While in this mode, pressing the number keys (1, 2, 3...)
will set the start point to the location of the corresponding source, if one
exists. Clicking the cross-section view toolbar button again shows the
cross-section.

In cross-section view mode, a smaller overview of the project area is
shown at top right. The cross-section endpoints shown in this view may
be dragged to move the location of the cross-section, which will update
automatically.
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2.1.5 Measuring distances

Pressing the ruler toolbar button allows the user to measure distances.
Click with the mouse at the location to measure from, and the cursor will
begin to show the distance from that point. While in this mode, pressing
the number keys (1, 2, 3...) will set the start point to the location of the
corresponding source, if one exists.

2.2 EXPORTING

2.2.1 Exporting the current scene to an image file

An image file containing the current scene may be exported by choosing
the 'Export the current scene as...' button from the Export menu. BMP,
JPG, PNG and PDF file types may be exported. If the current scene
includes calculated sound levels, then the exported image will include a
scale bar showing the colour scale for levels. The exported image can also
include text and an image, which are set under Preferences -> Exporting.

2.2.2 Exclusion zone export
For the exclusion zone you can choose to export as either ASCII grid (.asc)
or as ESRI shapefile (.shp).

2.2.3 Animated exports

If you have modelled a moving source, and ticked the “Moving sources
retain all calculated levels”box (memory intensive) then you can use this
tool to generate a .gif or .avi animation of the movement of your source.
This tool does a frame by frame animation of the track, not taking
movement speed into account.

2.2.4 Export to shapefile or ESRI ascii grid
A shapefile or ESRI ascii grid file is exported with current levels and geo-
referenced to the selected UTM-zone.
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2.3 SOLVERS

A range of calculation methods (solvers) are offered. Each given solver is
applicable to certain classes of problems, and the correct method should
be chosen for a given problem. A full description of the solvers is beyond
the scope of this document, and the interested reader is referred to

the references given below.

2.3.1 Split low/high frequency solvers

Different solvers may be chosen for the low and high frequency ranges.
The crossover frequency is chosen via the Frequencies and Solvers page.
A typical usage would be dBSeaModes for the low frequency range and
dBSeaRay for the high. The crossover frequency is given broadly as =
8d/c where fis the frequency in (Hz), dis the average depth (m) and cis
the speed of sound (m/s). Some experimentation may be required where
the depth varies greatly.

Added to the solver-calculated transmission loss, is the attenuation with
distance in seawater. This is insignificant at low frequencies and in the
human audio range, but at high frequencies can be significant, for
example attenuation is approximately 30 dB/km at 100 kHz. The
attenuation with frequency is graphed on the Water page, p 29.

2.3.2 20 log(r/ro)

Transmission loss is calculated based on simple geometric spreading, i.e.
an inverse square law. The calculated attenuation is spherically symmetric
and frequency independent. Bathymetry is ignored, absorption is
included.

2.3.3 20 log(rd/r0) + 10 log(r/rd)

Transmission loss is calculated according to the 20 log (r/r0) inverse
square law, until the distance from the source is greater than the water
depth at the source. From this point, levels drop according to 10 log (r/rd),
i.e. an inverse law. It is considered that the reflections from the seafloor
and the sea surface constrain the sound energy within the water layer,
and the problem becomes essentially 2-dimensional, or similar to a
vertical line source extending from the surface to the seafloor. Axially
symmetric, frequency independent. Bathymetry is ignored, with the
exception of the aforementioned calculation based on the water depth at
the source. Absorption is included.

2.3.4 dBSeaPE - parabolic equation method
The dBSeaPE solver utilises the so-called parabolic equation, and is range-
dependant, i.e. it takes variable bathymetry and water/sediment
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properties into account. dBSeaPE is suitable for low frequency problems.
The input to the solver is configured so that the sediment layer is
extended down to 2 times the depth of the water column, with the
attenuation rapidly increasing at the lowest depths. The intention is to
remove energy that would be reflected from the very bottom of the
sediment layer. The sea surface is a pressure-release interface.

As sharp discontinuities in density cause incorrect calculation results, the
density is smoothed between water and seabed, and between seabed
layers by means of a hyperbolic tangent function.

2.3.5 dBSeaModes - normal modes method

The normal modes are calculated for each water depth, based on the
sediment properties and water sound speed profile. The sound field is
calculated based on coupling between the calculated modes across the
interfaces between different depths. The calculation is of the adiabatic,
single forward scattering type. The overlying space is modelled as a
vacuum. dBeaModes is suitable where the frequency is low and/or the
water depth is shallow. The sediment layer is extended down well below
the depth of the water column, with the attenuation rapidly increasing at
the lowest depths. In this way, there are no modes where energy is
reflected from the very bottom of the sediment layer (the space
underneath the bottom of the sediment is also a vacuum).

The maximum number of modes to include in the solution may be limited
via the Preferences -> Advanced solver options. If the value is set to O, the
solver uses all the modes found by the eigenvalue search routine.

2.3.6 dBSeaRay - ray tracing method

The ray solver forms a solution by tracing rays from the source out into
the sound field. A large number of rays leave the source covering a range
of angles, and the sound level at each point in the receiving field is
calculated by combining the components from each individual ray. The
number of rays may be set on the Preferences -> Advanced solver
options. Setting this number to O instructs the solver to choose the
number of rays itself, however it is often the case that the number of rays
chosen is higher than needed, leading to excessive computation time. It is
often useful to set this number very low as a fast initial ‘checking' solve,
before increasing the number of rays and running a full solve which may
take some time. The overlying space is modelled as a vacuum. dBSeaRay
is suitable for high frequency problems.

When multiple seafloor layers are present, rays are not split and traced
into the seafloor. A complex reflection coefficient is calculated which is
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representative of the underlying layers, and this coefficient is applied to
the ray at the point of seafloor reflection. The calculation of the reflection
coefficient follows Computational Ocean Acoustics, Jensen et. al.
Springer, 2011 (section 1.6).

dBSeaRay is used for time domain calculations. Instead of returning a
transmission loss at each point in the slice, a list of ray arrivals is returned
(with separate entries for each frequency). These arrivals lists can be used
to calculate the effective time series at each point in the slice, which is
then used to calculate peak, peak to peak, and frequency band SEL levels.

These calculation methods are extensively documented in Computational
Ocean Acoustics, Jensen et. al. Springer, 2011.

2.3.7 Postprocessing of levels for each source

After a solve, the calculated transmission losses for each source are post-
processed. These steps are optional, and can be controlled from

the Preferences -> Advanced solver options page. The transmission loss is
made to decrease monotonically with increased distance from the source
(i.e. the level will decrease with distance from the source). In addition, the
transmission loss is averaged radially about the source. Averaging is
performed with a normalised triangular kernel of length 2em + 1, where m
is the Radial smoothing factor selected on the Preferences -> Advanced
solver options page, on the calculated transmission losses moving radially
around the source, for each range distance from the source. This option is
useful when dealing with results from a solver that change rapidly in the
radial direction.

To disable these postprocessing steps, set Radial smoothing factorto O
and uncheck Levels must decrease with distance from source.

Neither of these options has any effect when using the 10 log or 20 log
solvers.

2.3.8 Interpolating levels from sources to the grid

For each source, sound levels are calculated in 'slices' radiating out from
the source. The number of slices to calculate and the number of range
points along each slice can be changed on the Project setup 1.3 p. 8. These
sound levels are then interpolated onto the rectangular problem grid.
Therefore, at large distances from a source, there may be a significant
spacing between the calculated slices. If more detail is required in such an
area, then the number of solution slices should be increased.
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Figure 3.A single source in the problem area.
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Figure 4.The slices and solution points radiating out from the source.
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Figure 5.Example problem grid.

The overall sound levels are interpolated (and summed over all active
noise sources) to the rectangular problem grid.

2.4 READING CSV FILES

Bathymetry data is read into the program from comma separated value
(CSV) files. CSV files can be created in Excel or other similar programs.
Each 'pixel' is simply a depth in metres, separated by a semicolon or
comma. Example files may be found in the program directory. As CSV is
not a standardised format however, there are several problems that may
occur, depending on the specific file format.

Upon loading a CSV file, the program will ask whether the values are
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separated by commas or semicolons. It will also take a guess as to which
is the correct one. The CSV files created by different programs use slightly
different standards (and can also depend on locale settings, for example
MS Excel will use the current locale settings to choose delimiters and
decimal separators). For users from countries where numbers are written
123,45 rather than 123.45 this can cause confusion, as a comma is used as a
decimal separator rather than a value delimiter. To ensure correct import
of data, use a decimal point as the decimal separator.

Furthermore, some programs will place quote marks around each field,
giving ..."123.45";"45.6";"42"... which is currently not supported for import.

Another problem may be caused by end of line characters - the text
characters used to denote the end of a line differ between operating
systems. Therefore care should be taken with files created on non-
Windows machines (Apple, Linux, FreeBSD etc).

Please note that many files with the .csv extension are in fact .xyz files or
some variation thereof. CSVEditor expects .csv files to contain gridded
height/depth data, representing a raster. A common file format is 3
columns of text data, representing x,y, and depth (sometimes in another
order) points. Such files should be opened using the ''mport vector file
dialog.

It is a requirement that there are the exact same number of fields (i.e.
delimiters) on each line of the file. (Note that this is not a requirement for
ESRI ascii grid files, in that format the end of a row is found by using the
ncols parameter in the ESRI ascii header).

If a particular file is causing problems, this can often be fixed by opening
the file in a spreadsheet program such as Excel or LibreOffice Calc and re-
saving as a CSV file.

Very large CSV files can easily exceed the maximum size allowable in
spreadsheet programs. Large files can be edited with text editors such as
Emacs, Vim or Notepad++.

CSV Editor is included, which allows simple editing of CSV data and

conversion of shapefile or xyz formats. For more information see CSV
editor 2.8 p. 48.
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2.5 ADVANCED SOLVER OPTIONS

The Advancedtab in the preferences form allows more detailed control
of solver behaviour.

(Extensive documentation of all types of solvers is available in (Jensen, et
al., 2011).)

2.5.1 General options
Autosave:
Save the active project file after each solve if the project has a save file.

Remove levels below seafloor:
dBSeaModes and dBSeaPE calculate levels in the seafloor as part of a
solve. By default dBSea ignores these levels.

Levels must decrease with distance from the source:

The solver output is often more detailed than required. This option
ensures that sound levels will decrease monotonically with distance away
from each source, which is often useful where conservative design is
required. This can be applied and removed without recalculating levels in
the scenario.

Stop marching solution upon reaching land:

Whenever land is encountered the solver will stop the propagation
calculation. This is useful for limiting computational load when next to a
large landmass, but is not suitable when many small islands are present.

Frequency oversampling:

dBSea can solve for multiple evenly spaced frequencies in each frequency
band. For example, if the band centre is 1 kHz, the oversampling 5, and the
bandwidth is 1 octave, dBSea will solve at 757.9, 870.6, 1000, 1148.7 and
1319.5 Hz, and then average the results to give the level for that band. This
option is useful for modelling broadband noise sources and/or fast
changing environments. Increases computation time.

Radial smoothing factor and exclusion zone radial smoothing factor:
The solver output is often more detailed than required. dBSea smooths
results or exclusion zones radially around each source, with a triangular
kernel of length 2xfactor + 1. Set the factor to O for no smoothing.

2.5.2 Maximum attenuation layer thickness, in wavelengths
For dBSeaPE and dBSeaModes the sediment is set to attenuate sound so
that no sound is reflected from deep in the sediment. The user can set the
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depth at wich maximum attenuation occurs, relative to the wavelengths
in the scenario.

2.5.3 dBSeaPE

Depth and range oversampling:

The output from dBSeaPE is calculated at the range points and depth
points grid. These oversampling factors control the size of the
oversampled calculation grid that dBSeaPE uses internally. Increasing
these factors increases the accuracy of the calculated levels, at the cost of
increased solve time and memory requirements.

dBSea currently uses dBSeaModes to generate a starting field. This
approach can fail, in which case dBSeaPE uses Greene's starter (Jensen, et
al., 2011), a simpler (but less accurate) method of generating a starting
field.

Number of Padé terms:

Specify a number of Padé terms to use. A higher number will increase
accuracy of the prediction, but also decease solving speed. If "0", dBSea
will use "Greene's approximation" (Greene, 1984)

Setting the number of Padé terms at 5 is thought to be sufficient for most
scenarios (Collins, 1991). Note that using just one Padé term is inferior to
using Greene's approximation.

If the modal starter fails to find any modes, dBSea will let you know:

"PE solver used analytical starter f: 14813.9953965966 Hz, slices:
0, f: 18517.4942457458 Hz, slices: 0"

Figure 6. An example of the PE solver not finding any modes for the starting fields. Here provoked
by using very high frequencies (for the PE solver).

2.5.4 dBSeaRay

Calculate volume attenuation at each step:

dBSeaRay can calculate the accumulated attenuation in water for each
ray at every step. With this option turned off, the average of the source
and receiver depths is used. The volume attenuation is typically negligible
except for at high frequencies.

Runge-Kutta method:
The solvers rely on a smooth sound speed profile. dBsea uses the Runge-
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Kutta method to extrapolate from the provided sound speed profile if it is
likely to cause errors in the calculation. You can force dBSea to use either
2n or 4t order Runge-Kutta method if you wish.

Number of rays, start and end angles:

dBSea splits the sound leaving the source into N evenly spaced rays
between the start and end angle. O degrees is horizontal form the source,
-90 degrees is up and +90 degrees is down. Default number of rays is
1000.

Max number of reflections from seafloor:
After this number of reflections, the ray is terminated. In shallow water
scenarios this number should be high (>1000).

Initial step size (m):
Size of the first step in metres. The next step sizes depend on solver grid
resolution and ray path.

2.5.5 dBSeaModes

Max number of modes:

Enter a value other than zero to limit the number of modes to search for.
Setting zero lets dBSeaModes use all modes found by the eigenvalue
search routine.

Oversampling:
For more accurate results you can choose to oversample both with range
and depth.

2.6 PREFERENCES ¢

The Preferences page gives access to options relating to data Q
display and calculation.

2.6.1 Graphics

Immediately update results graphics - if ticked dBSea will update the
graphics layer as you are changing properties. This can lead to
performance issues on slower computers.

Max bathymetry graphics data - This determined the maximum amount
of data held in your graphics memory. It does not affect the resolution of
the actual calculation, only how much is displayed.
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Two drawing tweaks are available: Smooth result colours and Draw levels
with triangle algorithm. Use either to change the way results are
represented.

By default, probes are not included in exported images. To enable
exporting of probes, uncheck the 'Hide probes on image export box.

Levels display: Three methods are available for display of calculated levels.
With the default Max from all depths projected to surface option, for each
x and y location, the maximum sound level at any depth is found. This is
then displayed at the water surface. With the Single depth option, data
from a single depth is displayed at the correct depth. The display depth
may be changed with the Display solution depth # buttons. All depths can
be selected, and by adjusting opacity in Preferences>Graphics sizes.

The colours for display of various objects (land, water, background) can be
changed here.

2.6.2 Graphics sizes

Immediately update results graphics - if ticked dBSea will update the
graphics layer as you are changing properties. This can lead to
performance issues on slower computers.

Sliders control an array of display options.

2.6.3 Multi core

dBSea will by default use all available cores on your computer. If you wish
to work alongside a running solve, consider limiting the number of cores
that dBsea will use.

2.6.4 Directories options
The default save directory and the temporary working directory may be
changed here.

2.6.5 Misc. options
The units may be changed between metric and imperial. A name for the
project may be entered here.

2.6.6 Exporting options

An image and text may be chosen to include in exported image files. The
delimiter for CSV export may also be chosen (for ESRI Ascii export, the
delimiter is always the space character (ASCII 32).

2.6.7 Sound levels display
The type of sound levels to display may be chosen on this tab. The options
'dB SELcum' and 'dBpeak' may be used for assessment against the criteria
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defined in "Guidance for Assesing the Effects of Anthropogenic Sound on
Marine Mammal Hearing", (NOAA, 2016).

For converting between the available sound level types, an effective
assessment period is set on this tab. This time period is used when
converting between, for example, input sound sources given as SL, and
output levels as dB SELcum. Continuous sound sources (created via the
'Spectrum' button) are active throughout the entire assessment period,
unless modified by the 'Count' and/or 'Duty %' parameters.

2.7 DATABASES

Information on acoustical sources,
mitigation, material properties, -
criteria and sound speed profiles is
contained within two databases.

The program ships with a default

database, containing the default tame Basalt
data provided by dBSea Ltd. A cm/s) 5250
second database is created on the

user's computer (in the temporary

Seafloor properties

Basalt -

Density (kg/m?) 2700

directory, which by default is Amenuation (dhfwavelengh) (0.1
located at C:\Users\<username>\

AppData\Local\dBSea comments
Ltd\userLib.db), and the user may Jensenet.al. 2011

add and remove data freely in this
database. Each of the tabs

where the database is used allow
the user to add or remove data, as
shown in this example from the
seafloor tab: Database

Data source: default library

Save current properties

Clicking the 'Save current properties'

button will create an entry in the

user database with the current

name, with the given properties. Clicking 'Remove selected properties'
will remove the given entry (note that this button is only enabled when
the current entry is from the user database).

Entries from both databases are shown together in the dropdown menu.

The user database may be backed up by making a copy of the userLib.db
file. To restore this backup, simply copy the backed up file to it's original
location.
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Should the user database become corrupted, or to permanently clear all
user entries and start again, delete (or rename) this file and restart the
program, a new empty user database will be created.

2.8 CSVEDITOR

CSV Editor is used to prepare input topography data for use in dBSea. It
can read input data in a variety of formats, and produces correctly
formatted CSV data (CSV editor p 48) ready to be accepted by dBSea.

GIS data comes in a wide variety of different formats, each specific to a
particular use. CSV Editor attempts to interpret input data and prepare it
for use by dBSea. However, due to the large number of possible input
formats, it is not always possible to correctly interpret the input. It is
recommended that if the user has access to specialised GIS software, to
make use of that software to produce comma separated raster output
with a suitably chosen grid size, ready for use by the main program.
ESRI/ArcGIS ascii grid is a suitable and widely supported file format

that CSV Editor is able to read. Data imported in ascii grid format has the
added advantage that northing, easting and scaling data is included, and
will be passed on to dBSea, removing the need to separately set those
values within dBSea.

CSV Editor is able to import vector data from .shp (ESRI shapefile) and .xyz
formats. Raster data is generated from the imported vectors via a
Delaunay triangulation.

CSV Editor also allows the direct editing of depth data, by selection of an
area and raising or lowering the terrain as necessary.

2.8.1 Importing raster data

Choose a data file to open with the 'Open raster file' button. The entire file
is not read initially, instead sample data from the file will be displayed in
the fields to the right. If the data is not correctly interpreted, then use the
‘Delimiter, 'Header rows to ignore' and 'Reverse direction' options until
the data is correctly recognised. Then click the 'Parse raster file' button to
display the data graphically. Heights/depths of exactly O are considered
to be land.

2.8.2 Importing vector data

CSVEditor is able to import and convert vector data in .shp (ESRI
shapefile) or .xyz (text xyz points) formats. See CSV editor vector import p
49 for more information.
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2.8.3 Altering data

Large files may be reduced in size with the Tools>Save reduced version of
current file option. A higher decimating number reduces the size of the
output file, as each output data point is the average of m*m input data
points, where m is the decimation factor.

Left clicking and dragging in the data image area selects a rectangular
subset of the data (shown with an orange selection box) to edit. To select
a non-rectangular area, click individual points forming a polygon in the
image area. Double-click to confirm the selection. With an area selected,
the bathymetry within that area may be raised or lowered with the 'A/ter
selected terrain heights' buttons. Any changes may be removed with the
'Reset button. Changes to the terrain are reflected in the data image area.
Moving the mouse over the image area shows the current depth at the
cursor location.

2.8.4 Selecting an export range

The yellow selection rectangle shows the area of bathymetry that will be
exported. To alter the export range, either enter values in the 'Use data
subset boxes, or right click and drag in the image area.

2.8.5 Exporting selected data range
Clicking 'Export current selection' writes out the selected data to a file
which may then be opened in dBSea.

2.8.6 Troubleshooting
See CSV editor troubleshooting 2.10 p. 51.

2.9 CSV EDITOR VECTOR IMPORT

CSV Editor is able to import vector data from .shp (ESRI shapefile) and .xyz
formats. Raster data is generated from the imported vectors via a
Delaunay triangulation.

2.9.1 Importing vector data

Open the vector import form with the '/mport vector file' button. On this
form, a desired output file size can be chosen by setting the 'Target x or y
length' field. The input data will be triangulated to a grid with a maximum
side length of the given value. The file to open is chosen, either a .shp
(ESRI shapefile) or a .xyz (text xyz points) file.

Data import and triangulation may take some time, depending on the
desired output file size and the number of input points. The current limit
for total number of rows is approximately 2 million, although the exact
limit may vary depending on the details of the triangulation.
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2.9.2 Shapefile import

The shapefile format specifies many files that can be part of a 'shapefile’,
CSV requires two of these: a .SHP file containing the shapes/contours
themselves, and a .DBF database file containing information about the
shapes. The z height/depth data for each shape/contour is read from one
of the fields in the database file, and all the points in that shape are given
that height. A dialog will show upon selecting an import file, asking which
field contains the height/depth data. The .SHP and .DBF must have the
same name (excluding extension) and be located in the same directory.

2.9.3 XYZ import

XYZ is a commonly used format, despite not being well defined.
CSVEditor allows some variations on the basic format. When opening an
XYZ file, a form shows, asking whether:

- Data is arranged in 3 columns, giving X location, Y location, and
depth/height. Alternatively, columns may be ordered z, x, y.

- Header rows at the start of the file may be ignored. Click in the 'Ignore'
column to choose rows to ignore.

All data is in metres.

An example file viewed in a spreadsheet program:

A ] B | C [ D | E F
1 1777356,  3962665.6 10
2 1834515 3966812.8 10
3 185753.1  3973534.8 10
4 189985.2  3976379.1 20
5 1964234  3978692.5 20
6 201309.2  3975803.0 10
7 202698.6  3970608.1 10
8 2088525 39672419 20
9 215732.6 3965459 4 5
10 222774.2 3966739.5 2
1 2205528 3970631.8 30
12 2338495 3976403.0 30
13 2371352 39821314 30
14 | 2397845 3988041.9 30
15 243230.6  3993309.5 30
16 247758.4  3998085.1 3

254049 5 4001724 6 N

[
J
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Column A is the X location, column B the Y locaiton, and column C the Z
location.

The same file in a text editor:

-

177735.6,3962665.6,10
183451.5,3966812.8,10
185753.1,3973534.8,10
189985.2,3976379.1,20
196423.4,3978692.5,20
201309.2,3975803.0,10
202698.6,3970608.1,10
208852.5,3967241.9,20
215732.6,3965459.4,5

222774.2,3966739.5,2

229552.8,3970631.8,30
233849.5,3976403.0,30
237135.2,3982131.4,30
239784.5,3988041.9,30
243230.6,3993309.5,30
247758.4,3998085 30

o
I
wn

Fields may be delimited by comma or tab characters (ASCIl code 09). Line
endings should be Windows-style (ASCII 13, ASCII 10).

2.10CSV EDITOR TROUBLESHOOTING

CSV Editor attempts to cope with some of the common variations on
input GIS files. However, there are many reasons why an input file will not
correctly parse. Here are some guidelines for input data.

2.10.1 Raster import

Raster data must follow an exact grid, that is there must be an equal
number of columns in each row of the data. Each 'cell' is interpreted as
one pixel of depth data, and easting is considered to increase going along
a row of data. Cells must be equally spaced.

Many files with the extensions CSV, TXT, ASC, XYZ etc. in fact contain
vector data and in those cases it is appropriate to use the XYZ vector
import tool. If an input file has 3 columns of text data, it is very likely a
vector XYZ file rather than a raster. There are also raster gridded XYZ files
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(where the given points are located on a regular grid), however CSV Editor
also imports these using the XYZ vector import tool.

ESRI Ascii grid files commonly (but not exclusively) use the .ASC
extension. There are several variations on the file header data, such as
offering different X and Y cell sizes (using the DX and DY parameters in
place of CELLSIZE), or using latitude/longitude coordinates in place of
easting and northing given in metres. CSV Editor will attempt to interpret
the input file, but not all header variations are known and some manual
editing may be necessary. The delimiter for ESCI Ascii grid files is the
space character (ASCII code 32).

2.10.2Vector import

Whether the input file is .shp or .xyz, the quality of the generated raster
will depend on the spacing of the input points. Best results are achieved
where the given points are spread relatively evenly over the project area,
and there are no large areas where no points are found. Areas at the edge
of the map where there are no points will be shown in grey and will not
contribute to any calculations. Increasing the size of the output raster
gives greater resolution, at the expense of more calculation time, and the
added detail may not be warranted by the quality of the input data.

2.10.3 Shapefile import

Both a .SHP and .DBF file are required. The input shapes are interpreted as
contours, and the height/depth of each contour is read from one of the
numerical fields in the .DBF file. Input shapes where the height/depth
data is given by the z point coordinate are not currently supported.

2.10.4XYZ import

There are several different ways of expressing XYZ data, and XYZ files may
also use a variety of extensions. CSV Editor requires data to be comma or
tab separated, in three columns, showing x, y and z coordinates as shown
in CSV editor vector import 2.9 p. 49. Alternatively, the columns may be
ordered z, x, y. Ignore any non-numerical header rows by clicking in the
'Ignore' column. The distribution of the given points in space is not
important beyond the guidelines given above, so gridded XYZ files will
import as well as partially gridded files and files with
unstructured/unsorted point spacing.

2.11 HASP DONGLES AND TRIAL LICENSES

2.11.1 Trial licenses
Your distributor can provide you with a dBSea trial license. If dBSea opens
without a valid HASP dongle connected, it will request a trial license file.
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Choose the file, and dBSea will import the license and will be available in
trial mode until the trial period is over, or a valid HASP dongle is
connected.

Trial mode allows full use of dBSea, however export of levels or
bathymetry is disabled. In addition, exported images will have an overlaid
watermark.

Projects created and saved in the trial version of dBSea can be opened in
the full version, so if you start working on a project and then decide to
purchase the full version, your work will carry over.

2.11.2 HASP dongles

The full version of dBSea is secured using Sentinel HASP licensing. Your
HASP dongle will be sent to you by your distributor when you purchase
dBSea. The first time you insert the dongle, it will install the required
drivers which may take some time. If the driver install fails, drivers may be
downloaded from Safenet (External link). Once the drivers are installed,
your HASP dongle will be ready to use whenever inserted.

To use dBSea on a different computer, simply install dBSea and insert the
HASP dongle as before.

2.11.3 Demo version

If neither a HASP dongle or a trial license is found, dBSea will open in
demo mode. In this mode, import and export functions are disabled, as
are opening and saving of projects. Other functions are activated, so you
will be able to explore the program, work on and solve problems using the
default bathymetry.

2.11.4 Troubleshooting

Occasionally, there can be problems with installation of a trial license or
using the HASP dongle. In most cases, these can be solved by uninstalling
and reinstalling dBSea. If dBSea will not open after this step, please
contact your distributor, quoting any error messages displayed including
the error code (e.g. "1160: License file could not be decoded").

For network keys sometimes manual specification of IP addresses is
necessary:

The network Hasp Key can be situated on a computer outside the subnet
range of the local client machines accessing the HASP Key. However, the
IP address of the remote computer with the HASP key must be manually
entered on the client machines using the HASP License Manager as
follows:
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1.  On each of the client machines, type http://localhost:1947 in the
address bar of web browser, e.g. Internet Explorer, Chrome or
Mozilla, on the local machine that is to access to the HASP key
located on a different subnet. This starts the Hasp License Manager
interface.

2. Click the Configuration tab on the left-hand side menu.

3. Select the “Access to Remote License Managers” tab across the top
of the window.

4. Click the box next to “Aggressive Search for Remote Licenses”.

5. In the clear window next to “Remote Licence Search Parameters”
type in IP address of the server that holds the Hasp key and press the
Submit button.

6. Click the “Sentinel Keys” button on the left-hand side menu and wait
for the remote Hasp key to appear in the list of keys.

7. It may take some time but the remote Hasp key should be found
within 2 minutes.

8. Once the Hasp key appears in the list, you will be able to run dBSea.

9. You only have to do this setup once as the settings are stored in the
HASP License Manager on the local machine when the browser is
closed.

If this search fails, it’s likely you do not have access to the computer with
the HASP key. To confirm this open a “Command Prompt” (press #+R,
type “cmd” and hit “enter”). Type either “ping” or “tracert” followed by a
space and the IP address of the machine with the key. If the above does
not return either “reply” or “trace complete”, your machine is not
connected to the requested IP. A firewall, faulty network setup, or
hardware issues (are all cables connected?) could be the cause.

2.12 MINIMUM REQUIREMENTS

dBSea is available for Windows 7, 8 and 10. A computer that runs Windows
7 is capable of running dBSea. However, dBSea is both graphics and
processor intensive, and so in general it is recommended to run dBSea on
a machine with a fast processor and a graphics card. dBSea takes around
35 MB hard drive space, however the project files created are typically far
larger than this.

dBSea may be run from a networked location if desired. Performance
should not be significantly affected by network latency, for most tasks.
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The required database files are stored locally on the user's machine (under
{Users}/{Username}/Appdata/Local/dBSea Ltd) so database access is not
affected by the network.

dBSea is 64 bits. If a 32 bit version is required, contact your distributor. The
dBSea solvers run single threaded, and future versions are planned which
will take advantage of the multiple cores available on modern machines.

dBSea will run in linux with wine, but you’ll need to configure wine to use

the native version of usp10.dll before the built-in version (can be set up in

wine configuration menu). The HASP key is known to not be recognised in
Linux, we do not have a solution for that at present.
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